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Introducción
Descripción general de MIDI Song to Style

La aplicación MIDI Song to Style convierte automáticamente canciones MIDI (SMF: Archivo MIDI estándar; extensión: .mid) en 
archivos de estilo (.sty), lo que permite reproducir las canciones deseadas como estilos en el instrumento.

También puede escuchar y editar los datos convertidos:
- Reproducir canciones MIDI cargadas y cambio de asignaciones de voz para cada canal.

- Escuchar y editar los estilos convertidos.

Precauciones al utilizar la aplicación

• Esta aplicación (en lo sucesivo, la “aplicación”) recopila de forma anónima datos de uso de la función con el fin de mejorar la 

calidad del servicio y promocionar productos y servicios relacionados. No se recopilarán los datos que esté editando. Si no 
desea enviar el estado de uso, puede desactivarlo desde Ajustes (página 12).

• El propósito principal de esta aplicación es convertir canciones MIDI en archivos de estilo y no está diseñado para ser utilizado 

como un reproductor de música. Tenga en cuenta que las funciones de previsualización de la siguiente aplicación sólo sirven 
como soporte para la edición, y no se garantiza la compatibilidad total de la reproducción de audio, etc.

- Reproducción de canciones MIDI

- Reproducción de estilos convertidos
• Esta aplicación sólo puede utilizarse con modelos compatibles con el formato SFF GE (como Genos2).

Ordenador

Instrumento

MIDI Song to Style

Canción 
MIDI (.mid)

Estilo
(.sty)

Transferencia 
mediante cable 

USB o unidad flash 
USB
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Instalación
Conexiones y ajuste

Esta aplicación se puede utilizar de dos formas: conectándola al instrumento o utilizándola de forma independiente en un 
ordenador.

 Uso de la aplicación conectando el ordenador al instrumento
Se recomienda este método, ya que permite escuchar los cambios tal y como se oirían realmente.

Ejemplo de conexión

Para obtener instrucciones sobre cómo conectar el ordenador al instrumento, consulte el correspondiente manual de 
instrucciones.

Qué se puede hacer al conectar al instrumento:
• Reproducir archivos MIDI con los sonidos del instrumento.

• Escuchar los estilos convertidos con los sonidos del instrumento.

• Guardar (transferir) los archivos de estilo convertidos directamente en el instrumento.
• Especificar acordes en el teclado del instrumento mientras se escuchan los estilos convertidos.

Ajustes necesarios:
Abra [Preference] -> [MIDI Device] en el menú de la parte superior de la aplicación y, a continuación, configure el puerto como se 

indica a continuación.
• MIDI Input Device: Salida MIDI del instrumento

• MIDI Output Device: Entrada MIDI del instrumento

NOTA
Cuando se especifiquen acordes desde el instrumento mientras se escucha en esta aplicación, asegúrese de que el botón [ACMP] del 
instrumento esté apagado. (Si utiliza el instrumento con los archivos de estilo convertidos cargados, active [ACMP] como de 
costumbre). 

NOTA
Tanto la entrada como la salida deben estar configuradas en el instrumento para que la transferencia de archivos sea correcta.

Ordenador

Instrumento
Altavoces o 

salida de audio 
del instrumento

Cable USBMIDI Output Device

MIDI Input Device
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Instalación
 Utilizar la aplicación de forma autónoma con sólo un ordenador
Se puede utilizar esta aplicación por sí sola, sin necesidad de conectar el instrumento al ordenador. Aunque las voces y estilos 
no se reproducirán con la misma precisión, este método le permite trabajar sólo con el ordenador.

Ejemplo de conexión

Lo que se puede hacer sólo con un ordenador:
• Reproducir canciones MIDI utilizando los sonidos del sintetizador de software dentro de la aplicación (*1).

• Escuchar los estilos convertidos con los sonidos del sintetizador de software dentro de la aplicación (*1).
• Guardar el archivo de estilo convertido en el ordenador o transferirlo al instrumento mediante una unidad flash USB.

• Especificar acordes en la paleta de acordes de la aplicación (página 13) mientras se escuchan los estilos convertidos.

*1) Los sonidos no se reproducirán con total precisión.

Ajustes necesarios:
Abra [Preference] -> [MIDI Device] en el menú de la parte superior de la aplicación y, a continuación, configure el puerto como se 

indica a continuación.
• MIDI Input Device: Ninguno (debe seleccionarse si se dispone de un teclado MIDI, etc.)

• MIDI Output Device: MIDI Song to Style Synth, así como un dispositivo de audio para producir sonido

Dispositivo de 
audio interno 
del ordenador

Altavoces del 
ordenadorSintetizador 

de software 
integrado

Teclado MIDI, etc.

Ordenador

MIDI Output Device

MIDI Input Device
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Instalación
 Importar la lista de voces
Al cambiar las voces de cada canal de una canción MIDI que se ha cargado en esta aplicación (página 25), se pueden 
seleccionar las voces de la lista de voces de la aplicación. La lista de voces para la versión 1.00 del firmware Genos2 es la lista 

inicial de esta aplicación.

Al importar la lista de voces, se pueden hacer coincidir la lista de voces de esta aplicación con la del instrumento vinculado.
Para los productos compatibles, la información sobre el archivo de lista de voces para MIDI Song to Style se puede encontrar en 

la página del producto en el sitio web de Yamaha (https://www.yamaha.com/).

1. Seleccione [Edit] -> [Import Voice List] en el menú de la parte superior de la aplicación.
Se abrirá una ventana de selección de archivos.

2. Seleccione la lista de voces (.txt) del instrumento.
La lista de voces de la aplicación se actualizará con la lista cargada.
Si no aparece ningún mensaje de error, la carga ha finalizado.
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Guía Rápida/Descripción general
Cómo utilizar MIDI Song to Style

 La forma más sencilla de utilizarlo: Convertir y transferir

1. Arrastre y suelte el archivo SMF a MIDI Song to Style.

La canción MIDI que se ha transferido se analiza automáticamente y se convierte en un estilo, lo que permite reproducir y 

editar el estilo convertido dentro de la aplicación (página 16).

2. Transfiera los resultados del análisis como un archivo de estilo al instrumento. (Haga clic en 
el icono )
Existen dos formas para realizar la transferencia:

A) Guardar el archivo de estilo directamente en el instrumento a través de la conexión del cable USB (Guardar 
en el instrumento).
(Puede transferir el archivo cuando el ordenador esté conectado al instrumento mediante un cable USB. Consulte 

página 3 para los ajustes necesarios). 

B) Guárdelo como un archivo de estilo en una unidad flash USB y luego transfiera el archivo al instrumento 
(Guardar en el ordenador).

3. Toque el instrumento con el estilo transferido.

1 2

Ordenador

MIDI Song to Style

Canción 
MIDI (.mid)

Estilo
(.sty)

Transferencia 
mediante cable 

USB o unidad flash 
USB

Instrumento

Archivo de canción MIDI
Formato de archivo MIDI estándar 
(.mid)
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Guía Rápida/Descripción general
 Reanalizar cambiando las condiciones del análisis
Si los resultados de la conversión automática de estilo no son los deseados, puede cambiar las condiciones del análisis y 
convertir de nuevo la canción MIDI que se ha cargado.

• No incluya el canal de melodía principal ni otros canales que no desee incluir en el estilo (página 19).

 Editar el estilo convertido automáticamente
Puede editar manualmente el estilo convertido automáticamente de las siguientes maneras.

• Cambiar el registro extraído de una canción MIDI como una sección (página 20) 
• Reordenar secciones (página 21) 

• Seleccionar un nuevo registro y asignarlo a una sección (página 22) 

• Cambiar las asignaciones de canal MIDI de cada parte de estilo para cada sección (página 24) 
• Cambiar la voz de cada canal de una canción MIDI (página 25) 

• Cambiar/restablecer el volumen de cada parte de un estilo (página 26) 

• Cambiar el compás del estilo o la signatura de compás (página 26)
7



Guía Rápida/Descripción general
Guardar o cargar los datos editados hasta el momento (Proyecto)

Se pueden guardar o cargar las canciones MIDI, incluyendo la información analizada y los contenidos editados, como un archivo 
de proyecto en un formato de archivo específico (.sts).

En el archivo del proyecto se guardan los siguientes contenidos:
• Contenido de la canción MIDI cargada (archivo SMF)

• Resultados del análisis automático de una canción MIDI

• El estado de edición del estilo, incluidas las asignaciones de secciones y partes

Guardar un proyecto
Abra [File] -> [Save Project] en el menú de la parte superior de la aplicación y especifique la ubicación para guardar.

 Cargar un proyecto
Abra [File] -> [Open Project] en el menú de la parte superior de la aplicación y seleccione el archivo de proyecto deseado. 

También puede arrastrar y soltar el archivo del proyecto en la aplicación.
8



Funciones (Descripción de la pantalla)
Transiciones de la pantalla

A continuación se muestra un esquema de las transiciones de visualización que aparecen tras iniciar la aplicación.

Al inicio

Ajustes MIDI

Otros ajustes

Inicio (Easy)

Paleta de acordes (ventana independiente)

Inicio (Edit)

Guardar Estilos

Edición detallada (ventana aparte)

Edición de los parámetros de la sección

Carga de archivos

Cambio de modo
9



Funciones (Descripción de la pantalla)
Funciones de la pantalla

En este apartado se explica qué se puede hacer desde cada una de las pantallas mostradas en el esquema anterior.

 Pantalla Inicio (Easy)

q Controles para la reproducción de canciones MIDI

w Abre la pantalla para cargar un nuevo archivo

e Cambia el modo de visualización de inicio (Easy  Edit)

r Abre la ventana Ajustes MIDI (página 12)

t Abre la ventana Otros ajustes (página 12)

y Para reproducir secciones del estilo convertido (página 16)

u Muestra el acorde especificado durante la reproducción del estilo y abre la ventana de la paleta 
de acordes (página 13)

i Abre la pantalla Guardar estilo (página 18) 

q

t

y

e

r

w

u

i
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Funciones (Descripción de la pantalla)
 Pantalla de inicio (Edit)

Las funciones q a i son las mismas que las de la pantalla Inicio (Easy).

o Vuelve a analizar después de cambiar la configuración del análisis automático (página 19).

!0 Comprueba y gestiona cada canal para la reproducción de la canción MIDI.
• Muestra el tipo aproximado de voz (sólo en pantalla).

• Determina el ajuste de activado/desactivado (silenciamiento) de cada canal.

!1 Muestra la descripción general de los datos de la canción MIDI y permite editar las secciones 
de estilo.
• Muestra la descripción general de datos de cada canal para una canción MIDI (sólo visualización).

• Edita la sección de estilo (página 20).
• Cambia las asignaciones de canal MIDI de cada parte de estilo (página 24).

!2 Cambia la ampliación de la visualización de la descripción general de los datos de la canción 
MIDI (!1).

!3 Muestra y permite cambiar varios ajustes del estilo (páginas 17, 26).
• Tempo (sólo visualización)

• Signatura de compás (Compás)

• Activado/Desactivado y volumen de cada parte de estilo
• Tecla de sección

!3

u

!1

!2

t

y

r

e

!0

qo wi
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Funciones (Descripción de la pantalla)
Pantalla de ajustes MIDI

q Determina el MIDI Input Device.

w Determina el MIDI Output Device.
Si selecciona “MIDI Song to Style Synth”, también tendrá que configurar el destino de salida del audio.

e Actualiza la lista de dispositivos MIDI.

 Pantalla de otros ajustes

q Determina el tamaño máximo de los archivos de estilo convertidos.

w Determina si la ventana Paleta de acordes (página 13) se abre automáticamente al reproducir un 
estilo.

e Determina si se permite la recopilación de datos anónimos sobre el estado de uso de esta 
aplicación.

w

q

e

q

w

e
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Funciones (Descripción de la pantalla)
 Ventana Paleta de acordes
Esta ventana le permite especificar el acorde utilizado cuando se reproduce el estilo.

q Especifica la raíz del acorde.

w Especifica el tipo de acorde.
La abreviatura “cc” significa “acorde cancelado” (sin acorde especificado).

e Activa/desactiva el acorde En bajo y le permite especificar la nota de bajo.

r Muestra el acorde especificado.

e

w

r

q
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Funciones (Descripción de la pantalla)
 Ventana Edición detallada
Esta ventana le permite editar los ajustes del canal de la canción MIDI y cambiar los ajustes detallados de cada parte en la 
sección de estilos.

q Controles para la reproducción de canciones MIDI.

w Determina el ajuste de activado/desactivado (silenciamiento) de cada canal MIDI.

e Restablece la configuración del canal MIDI.
Restablece el estado anterior a la edición.

r Determina la voz para cada canal MIDI.
Puede especificarlo mediante números de cambio de programa o nombres de voz.

La lista de voces importada (página 5) se utiliza para configurar el nombre de la voz.

Los colores dados a los números de voz o a los nombres de voz indican las siguientes condiciones.

t Determina el volumen para cada canal MIDI.

Blanco Sin editar y la voz no cambiará durante la secuencia.

Amarillo Sin editar y la voz cambiará durante la secuencia.

Naranja La voz se ajustó manualmente.

ew q

i u t y

r
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Funciones (Descripción de la pantalla)
y Muestra el estado del volumen de cada canal MIDI.
Los tres tipos de condiciones de volumen se indican a continuación.

u Restablece todos los ajustes de los canales MIDI.

i Muestra el estado de asignación de cada canal para la sección y abre los ajustes detallados de 
las partes de estilo.
Muestra las asignaciones de parte para cada canal en cada sección del estilo.

Se utilizan las siguientes abreviaturas de pantalla.

Nombre de la sección

Nombres de las partes del estilo

Haciendo clic en el nombre de cada parte de estilo podrá editar los parámetros detallados de las partes dentro de cada 

sección.

Si desea más información detallada sobre los parámetros, consulte página 29.

Blanco Sin editar y el volumen no cambiará durante la secuencia.

Amarillo Sin editar y el volumen cambiará durante la secuencia.

Naranja El volumen se ajustó manualmente.

I1 a 3 Intro I a III

MA a MD Main A a D

FA a FD Fill In A a D

BK Break

E1 a E3 Ending I a III

R1, R2 Rhy1, Rhy2

Bs Bass

C1, C2 Chd1, Chd2

Pd Pad

P1, P2 Phr1, Phr2

NOTA
Dado que los parámetros detallados se ajustan automáticamente en función de los resultados del análisis, normalmente no es 
necesario editarlos.
15



Cómo utilizar la aplicación
Reproducir (escuchar) el estilo convertido

Puede probar cómo suena el estilo convertido mientras especifica el acorde.

 Reproducción de estilos

1. Haga clic en el icono correspondiente a la secciones que desee reproducir.

El icono de sección se mostrará como en reproducción (resaltado) y la sección se reproducirá en bucle.

En este ejemplo, se reproduce Main B.

Además, por defecto, la ventana Paleta de acordes (página 13) se abre automáticamente.

2. Controla la reproducción de estilos, como el cambio de secciones y la especificación de 
acordes.
• Si hace clic en el icono de otra sección, se reproducirá esa sección.
• Puede comprobar el cambio en el sonido mientras especifica el acorde desde la ventana Paleta de acordes o el 

instrumento que se ha seleccionado como MIDI Input Device.

3. Haga clic en el icono de la sección que se está reproduciendo para detener la reproducción 
del estilo.

Determina el ajuste de activación/desactivación de la reproducción del bucle de 
sección.
Con los ajustes predeterminados de esta aplicación, cada sección se reproduce en un bucle que permite comprobar el 
contenido del estilo. Este comportamiento difiere del de los instrumentos normales equipados con estilo. Si desea cambiar el 

comportamiento de las secciones que normalmente no se reproducen en bucle (Intro I a III, Fill In A a D, Break y Ending I a III) 

para que no se reproduzcan en bucle, haga clic en la marca  en la parte superior derecha del icono. La pantalla cambiará a 
 (bucle desactivado) y esas secciones se reproducirán sólo una vez, y luego se reanudará la reproducción del estilo, como 

es habitual en los teclados digitales equipados con estilo.
16



Cómo utilizar la aplicación
 Activación/desactivación de cada parte de estilo durante la reproducción
En la pantalla Inicio (Edit), puede activar/desactivar (silenciar) cada parte.

Haga clic en cada nombre de parte de estilo para activar/desactivar.

Las partes que estén desactivadas aparecerán en gris.

En este ejemplo, Chd1 y Chd2 están desactivados.
17



Cómo utilizar la aplicación
Guardar y transferir los estilos convertidos

Los resultados de la conversión pueden guardarse en el ordenador o transferirse al instrumento conectado como archivo de estilo 
(.sty).

1. Haga clic en el icono .

2. Seleccione cómo para guardar el archivo.
• [Save to Instrument]: Permite transferir y guardar archivos de estilo directamente en el instrumento.

El archivo se guardará en la carpeta raíz de la unidad de usuario.

• [Save to Computer]: Guarda los archivos de estilo en el ordenador.

3. Siga las instrucciones en pantalla para guardar o transferir.
A) Para [Save to Instrument] (transferir directamente al instrumento)

Escriba un nombre y haga clic en [Save to Instrument] para iniciar la transferencia.

B) Para [Save to Computer] (guardar en el ordenador)
Cuando aparezca el cuadro de diálogo para guardar el archivo, escriba un nombre y guárdelo en la ubicación 

deseada.

Cuando transfiera datos al instrumento, utilice una unidad flash USB.

NOTA
Si desea cancelar la operación de guardado, haga clic de nuevo en el icono .

NOTA
[Save to Instrument] sólo puede utilizarse cuando el ordenador esté conectado al instrumento por un cable USB. Consulte las 
instrucciones en página 3.
18



Cómo utilizar la aplicación
Cambiar los ajustes predefinidos del análisis automático

Las condiciones de análisis de las canciones MIDI se ajustan automáticamente, pero ello puede dar lugar a resultados no 
deseados en función de los datos MIDI concretos. La opción de incluir o no cada canal en el análisis puede modificarse para 

volver a analizar los datos y obtener los resultados deseados.

 Especificar manualmente los canales que desea excluir del análisis y volver a analizarlos

1. Ponga la pantalla Inicio en modo Edit.

2. Haga clic en [Reanalyze Setting].

Se abrirá la pantalla de ajustes del análisis.

3. Cambie los ajustes de exclusión de canales tal como desee.

Edite las marcas de verificación de las fichas [Melody] y [Assign] según sea necesario.
• Pestaña [Melody]: Los canales marcados se tratarán como la “melodía principal”

Los canales de la melodía principal se utilizan para estimar el registro de la sección.

Cuando active la pestaña [Melody], la pestaña [Assign] se desactiva automáticamente.
Para el valor inicial, se reflejan los resultados de la identificación automática de la melodía principal.

Marque los canales que desee especificar como melodía principal (por ejemplo, el canal que 

contiene las notas que desea reproducir).
• Pestaña [Assign]: Los canales marcados son partes que pueden asignarse a partes de estilo.

Si no quiere que el sonido de interpretación de un canal específico se incluya en el estilo convertido, 

desmarque ese canal.

4. Haga clic en [Reanalyze] para volver a realizar el análisis.
Se actualizarán los resultados de la conversión.
19



Cómo utilizar la aplicación
Editar el estilo convertido

En el modo Edit (página 11) de la pantalla Inicio, puede modificar un estilo convertido automáticamente según sea necesario para 
lograr el resultado de conversión que desee.

 Modificar el registro de las secciones

1. Haga clic en el nombre de la sección en la parte superior de la pantalla y seleccione la 
sección cuyo registro desee cambiar.

La sección seleccionada quedará resaltada. En este ejemplo, se ha seleccionado Intro II.

2. Arrastre el borde derecho o izquierdo del registro de sección para ajustar el registro como 
desee.

Se ha modificado el registro de la sección.

NOTA
Las operaciones de edición introducidas en este capítulo pueden deshacerse o rehacerse utilizando [Edit] -> [Undo]/[Redo] en el menú de 
la parte superior de la aplicación.
20



Cómo utilizar la aplicación
 Reordenar las secciones
Si los resultados de la asignación automática de secciones no están en el orden deseado, puede reordenar las secciones.

1. Haga clic en el nombre de la sección en la parte superior de la pantalla y seleccione la 
sección desee cambiar.

La sección seleccionada quedará resaltada. En este ejemplo, seleccionamos Main D.

2. Vuelva a hacer clic en el nombre de la sección seleccionada.

Se abre la ventana emergente para la asignación de secciones.

3. Seleccione el nombre de sección para el destino de sustitución y haga clic en [Assign] para 
confirmar.

Se ha modificado la asignación de la sección. En este ejemplo, se han sustituido Main A y Main D.

NOTA
Puede mantener la naturalidad sustituyendo la sección Main y la sección Fill In como un conjunto.

Puede mantener una sensación natural sustituyendo la sección Main y la sección Fill In como un conjunto. Por ejemplo, cuando 
sustituya Main B por Main C, deberá sustituir también Fill B por Fill C para garantizar la coherencia entre los patrones.
21



Cómo utilizar la aplicación
 Asignar una nueva sección (manualmente)
Puede especificar el registro deseado que se utilizará para asignar una nueva sección.

1. En la pantalla, seleccione el registro al que desea asignar.

Se visualizará el registro seleccionado.

2. Haga clic en .

Se abre la ventana emergente para la asignación de secciones.

3. Seleccione el nombre de la sección a la que desea asignar el registro seleccionado y haga clic 
en [Assign] para confirmar.
• Cuando seleccione una sección sin asignaciones existentes, se añadirá una nueva sección.
• Cuando seleccione una sección con asignaciones existentes, la sección existente se eliminará y se sustituirá por el 

nuevo registro.

En este ejemplo, el registro seleccionado se añade como Intro I.
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Cómo utilizar la aplicación
 Borrar secciones
Puede borrar las secciones innecesarias.

1. Haga clic con el botón derecho del ratón en el nombre de la sección que desea borrar.

Se abre un menú de borrado.

2. Haga clic en [Delete <Nombre de sección>].
La secciones se borrará.
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Cómo utilizar la aplicación
 Cambiar la combinación de partes y canales MIDI dentro de una sección
La asignación para la cual los canales MIDI individuales se convierten en partes de estilo específicas puede cambiarse de 
manera independiente para cada sección.

1. Haga clic en nombre de la sección en la parte superior de la pantalla y seleccione la sección 
que desee cambiar.

Se mostrará el estado de asignación de canal para cada Parte en la sección seleccionada.

2. Arrastre y suelte la parte cuya asignación desea cambiar.

Se han sustituido la parte de fuente de arrastre y la parte de destino de arrastre.

Borrar o añadir partes de una sección
Puede borrar una asignación de parte haciendo clic en el icono [-] situado junto al nombre de la parte.

Se muestra un icono [+] para los canales no asignados que tienen datos de interpretación dentro del registro de la sección.

Haciendo clic en ese icono [+] podrá seleccionar y asignar una parte de sección.
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Cómo utilizar la aplicación
 Cambiar la voz de cada canal de una canción (Edición detallada)
Puede pasar de las voces genéricas especificadas en una canción MIDI a las voces de mayor calidad exclusivas del instrumento.

1. Seleccione [Edit] -> [Open DetailEdit  Window] en el menú de la parte superior de la 
aplicación.
Se abre la ventana para una edición detallada.

2. Cambie los ajustes de voz para cada canal.

Puede ajustarlos por medio de números de cambio de programa o nombres de voz.

La lista de voces importada (página 5) se utiliza para configurar el nombre de la voz.
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Cómo utilizar la aplicación
 Cambiar/restablecer el volumen de cada parte de un estilo
Puede cambiar el volumen de cada parte de estilo en todas las secciones.

El volumen de cada parte puede ajustarse accionando los mandos situados debajo de los nombres de cada parte de estilo. 

Alternativamente, los valores pueden editarse directamente.

Si desea restablecer el volumen modificado a su estado inicial (el estado cuando se cargó la canción MIDI), realice una de las 

siguientes acciones:
• En el menú de la parte superior de la aplicación, abra [Edit] -> [Reset Style Parameter] -> [Volume] y seleccione la parte que 

desee restablecer.

• Mantenga pulsada la tecla CTRL (Windows) o Comando (Mac) y haga clic en el mando correspondiente a la parte que desea 
restablecer.

Si desea restaurar el cambio anterior, seleccione [Edit] -> [Undo].

 Cambiar el compás del estilo (Signatura de compás)
Puede cambiar los ajustes del compás del estilo (signatura de compás) después de la conversión.

Haga clic en la zona “Beat” de la parte inferior de la pantalla y ajuste el valor.

 Cambiar la tecla de la sección de estilo
Section key (Section Key Signature) es un parámetro que indica en qué clave se basan los datos de cada sección.
Cuando especifique acordes con la misma nota fundamental que esta clave durante la reproducción del estilo, las secciones Intro 

y Coda se reproducirán con el mismo tono que la canción MIDI antes de la conversión. Seleccione el nombre de la sección que 

desea cambiar en la parte superior de la pantalla y, a continuación, haga clic en el área “Section Key” en la parte inferior de la 
pantalla para establecer el valor.
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Apéndice
Terminología

 Canciones MIDI (SMF)
• Datos de partituras de música electrónica. Cargar esos datos en un dispositivo compatible permite reproducir música.

• Incluye 16 “Canales” que permiten especificar diferentes voces (sonidos de instrumentos), volumen y contenido de 
interpretación.

• SMF (archivo MIDI estándar) (.mid) es el nombre del formato estándar de los archivos MIDI.

 Términos relacionados con el estilo
Sección:
Grupo colectivo de datos musicales (o patrón) que se utiliza para construir una canción.

En función del progreso de la interpretación o de la canción, las secciones cambian automática o manualmente.
Las secciones incluyen Intro I-III, Main A-D, Fill In A-D, Break y Ending I-III.

Ejemplo de reproducción:

Parte:
Un componente dentro de una sección. Las voces, etc. pueden ajustarse individualmente para cada parte. Las partes son 

equivalentes a los canales de una canción MIDI.
Las partes incluyen Rhythm 1-2, Bass, Chord 1-2, Pad, y Phrase 1-2.

Archivo de estilo: 
El formato de archivos de estilos (SFF) es un formato relacionado con la función de acompañamiento automático de Yamaha 

(estilo).

Existen dos formatos: SFF y SFF GE.
SFF GE (Edición para guitarra) es un formato ampliado de SFF que mejora aún más la expresividad de las voces de guitarra.

MIDI Song to Style exporta archivos de estilo en formato SFF GE.

NOTA
La conversión automática en MIDI Song to Style siempre deja algunas secciones (Intro I, Break, Ending I, Ending III) sin asignar, por lo 
que es necesario (y deseable) asignarlas manualmente.

Operación

Reproducción
de estilos

INTRO
[I]

START/
STOP

MAIN
[B]

ENDING
[II]

Parada
Intro I

(una vez)
Main A
(bucle)

Fill In B
(una vez)

Main B
(bucle)

Ending II
(una vez)

Main A

Rhythm 1

Rhythm 2

Bass

Chord 1

Chord 2

Pad

Phrase 1

Phrase 2

Main B

Rhythm 1

Rhythm 2

Bass

Chord 1

Chord 2

Pad

Phrase 1

Phrase 2
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Lista de menús

* Para la versión Mac, este menú se encuentra en el menú de la aplicación “MIDI Song to Style”.

Menú Descripción

File

Open SMF Carga archivos de canciones MIDI (.mid,.midi).

Save Style File Guarda el archivo de estilo convertido en el ordenador.

Open Project
Carga el archivo de proyecto (.sts) y reproduce el estado de edición en el momento de 
guardar.

Save Project
Guarda el proyecto que se está editando en un archivo de proyecto en formato 
propietario (.sts).

Recent Files Selecciona los archivos abiertos recientemente.

Exit (Quit)* Sale de la aplicación.

Edit

Undo Devuelve el estado de edición al paso anterior.

Redo Después de aplicar Undo, avanza el estado de edición un paso hacia adelante.

Open DetailEdit Window Abre la ventana Edición detallada.

Import Voice List

Importa la lista de voces.

NOTA
La lista de voces se utiliza para especificar voces en la ventana de edición detallada.

Reset Style Parameter Volume Restablece el volumen para cada parte del estilo.

Help

Manual Visualiza el Manual de instrucciones (este documento).

Privacy Statement Muestra la política de privacidad.

About* Muestra la versión de la aplicación y el copyright.
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Apéndice
Teclas de acceso directo

Ventana de edición detallada: Editar los parámetros de sección

La ventana de edición de los parámetros de sección se abre al hacer clic en una parte dentro de una sección en la ventana 

Edición detallada (página 14).

Operación Atajo

Carga un archivo de canción MIDI (.mid) Ctrl + Mayús + O

Guarda un archivo de estilo (.sty) Ctrl + Mayús + S

Cargar un archivo de proyecto (.sts) Ctrl + O

Guardar un archivo de proyecto (. sts) Ctrl + S

Undo Ctrl + Z

Redo Ctrl + Mayús + Z

Abrir la pantalla de edición detallada Ctrl + Mayús + D

Reproducir/parar una canción MIDI Tecla de espacio

NOTA
• Es posible que las teclas de acceso directo no estén disponibles inmediatamente después de introducir los números en el teclado. Si 

esto ocurre, pulse una vez en cualquier lugar de la pantalla para activar los accesos directos.

• Para Mac, sustituya Ctrl por Comando.
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 Descripción de cada elemento de la pantalla

Nombre del elemento Descripción

Section Setting Cambia la sección a editar.
Sólo para este elemento, la visualización del nombre de la sección difiere de la 
visualización normal. Sustituya los nombres de las secciones por los siguientes 
cuando los vea:
• Intro A-C: Intro I-III
• Fill In AA-DD: Fill In A-D
• Fill In BA: Break
• Ending A-C: Ending I-III

Key Signature Determina la Section Key Signature.

Channel Setting Cambia el canal MIDI a editar dentro de la sección seleccionada.

Attribute Muestra los atributos del canal (resultados del análisis automático).

Style Part Muestra la asignación de parte del canal seleccionado dentro de una sección.

Zone Setting Divide el área y establece la operación para los canales anteriores (partes de 
estilo asignadas a canales) dentro de un registro de sección.

Lo Zone Split Determina dónde separar Lo Zone y Main Zone.
Introduzca el valor de nota más grave (-, 1 a 127) de la Main Zone.
Si el valor es “-”, se desactivarán los ajustes de la Lo Zone.

Style Playing 
Parameter

Muestra el Style Playing Parameter para Lo Zone (no se permite el ajuste 
automático ni la edición).

Convert to Style 
Parameter

Determina las reglas de conversión de nota para la Lo Zone al convertir a un 
estilo.
Hay cuatro opciones: Root only, Active for Main, Semi-active Bass, y -.

HiKey
(High Key)

Determina el valor estándar (0 a 11: C a B) para cambiar si se sube/baja el tono 
durante la reproducción de estilos para la Lo Zone.
Cuando se especifica una nota superior a este valor como nota fundamental del 
acorde durante la reproducción, la transposición será hacia abajo.

LoLim
(Low Limit)

Determina el valor mínimo de transposición (0 a 127) durante la reproducción de 
estilos para la Lo Zone.
Si el resultado del cálculo de transposición se convierte en un número inferior a 
este valor durante la reproducción, se realizarán acciones como el plegado de 
octavas o la detención del sonido de acuerdo con el Style Playing Parameter.

HiLim
(High Limit)

Determina el valor máximo de transposición (0 a 127) durante la reproducción 
de estilos para Lo Zone.
Si el resultado del cálculo de transposición se convierte en un número superior a 
este valor durante la reproducción, se realizarán acciones como el plegado de 
octavas o la detención del sonido de acuerdo con el Style Playing Parameter.
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Zone Setting Main Zone Style Playing 
Parameter

Determina el Style Playing Parameter para Main Zone.

Convert to Style 
Parameter

Determina las reglas de conversión de nota para Main Zone al convertir a un 
estilo.

HiKey 
(High Key)

Determina el valor estándar (0 a 11: C a B) para cambiar si se sube/baja el tono 
durante la reproducción de estilos para la Main Zone.
Cuando se especifica una nota superior a este valor como nota fundamental del 
acorde durante la reproducción, la transposición será hacia abajo.

LoLim 
(Low Limit)

Determina el valor mínimo de transposición (0 a 127) durante la reproducción de 
estilos para Main Zone.
Si el resultado del cálculo de transposición se convierte en un número inferior a 
este valor durante la reproducción, se realizarán acciones como el plegado de 
octavas o la detención del sonido de acuerdo con el Style Playing Parameter.

HiLim 
(High Limit)

Determina el valor máximo de transposición (0 a 127) durante la reproducción 
de Estilos para Main Zone.
Si el resultado del cálculo de transposición se convierte en un número superior a 
este valor durante la reproducción, se realizarán acciones como el plegado de 
octavas o la detención del sonido de acuerdo con el Style Playing Parameter.

Hi Zone Mega Voice Determina si se realiza el procesamiento MegaVoice en las notas de Hi Zone 
(C6 o superior).
Si está marcada, las notas por encima de C6 o superiores no se convertirán y 
seguirán reproduciéndose correctamente al utilizar MegaVoice.

Nombre del elemento Descripción
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 Acerca de Style Playing Parameters
Son reglas de conversión de nota que permiten que cada parte de una sección corresponda a una especificación de acorde 
durante la reproducción de un estilo.

La elección de ajustes predefinidos que se ajusten a las características de cada parte garantizará la calidad y precisión de su 

interpretación.

 Acerca de Convert to Style Parameters
Estas son las reglas para convertir notas en canales a notas en partes de estilo.

Nombre del ajuste 
predefinido

Descripción

Bass Para la parte de graves de la sección Main/Fill.

Bass (Intro) Para la parte de graves de la sección Intro/Ending.

Chord Para una parte que consiste principalmente en acordes de varias notas de la sección Main/Fill.

Phrase chordal
Para una parte que consiste principalmente en acordes dispersos de una sola nota (arpegios, etc.) de la 
sección Main/Fill.

Phrase melodic Para una parte que consiste principalmente en frases melódicas de una sola nota de la sección Main/Fill.

Guitar Stroke
Para una parte que utiliza una voz de guitarra y consiste principalmente en acordes de varias notas (golpes 
de acorde, etc.) de la sección Main/Fill.

Guitar Arpeggio
Para una parte que utiliza una voz de guitarra y está formada principalmente por acordes dispersos de una 
sola nota (arpegios, etc.) de la sección Main/Fill.

Chromatic Para una parte que consta principalmente de frases de escala cromática de la sección Main/Fill.

Maj-min (Intro) Para una parte que no sea graves y Phr1-2, de la sección Intro/Ending.

Drum with cymbal Para una parte que utiliza un conjunto de batería con platos Crash.

Drum no cymbal Para una parte que utiliza un conjunto de batería sin platos Crash.

SFX Para una parte que utiliza el kit SFX.

- Sin asignación (si no hay asignación de parte).

NOTA
Las partes ajustadas a Bass (Intro) o Maj-min (Intro) están fuertemente influenciadas por la clave de la sección de esa parte.

Nombre del ajuste 
predefinido

Descripción

no change Las notas no se modificarán.

Root only Sólo se reproduce la nota fundamental del acorde.

Root & 5th Sólo se reproducirán la nota fundamental del acorde y la 5.ª perfecta.

Semi-active Bass
Se reproducirá la interpretación original con algunas posibles limitaciones. La estabilidad 
general y la idoneidad para especificar acordes durante la reproducción de Estilos 
pueden ser inferiores a “Root Only”.

Stable for Main
La reproducción estable de acordes de varias notas es posible para acordes 
especificados durante la reproducción de estilos.
Sin embargo, es posible que la interpretación original no se reproduzca con exactitud.

Active for Main
Si los resultados del análisis de acordes durante el análisis son adecuados, la 
interpretación original se reproducirá con precisión. Si hay errores en los resultados del 
análisis de acordes, el estilo convertido puede ser musicalmente inapropiado.

Guitar Stroke Ajustes exclusivos de “Guitar Stroke”.

Guitar Arpeggio Ajustes exclusivos de “Guitar Arpeggio”
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 Restricciones en las opciones de Convert to Style Parameter
Las opciones de Convert to Style Parameter cambian en función de los ajustes de Style Playing Parameter, como se muestra en 
la tabla siguiente.

Style Playing Parameter

Bass
Bass 
(Intro)

Chord
Phrase 
chordal

Phrase 
melodic

Guitar 
Stroke

Guitar 
Arpeggio

Chromatic, 
Maj-min (Intro), 
Drums with cymbals, 
Drums without 
cymbals, SFX

Convert to Style 
Parameter 

no change  

Root only   

Root & 5th  

Semi-active 
Bass



Stable for Main   

Active for Main    

Active root 
only

 

Active root & 
5th

 

Guitar Stroke 

Guitar 
Arpeggio


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Resolución de problemas

Si la aplicación no funciona normalmente, realice las siguientes comprobaciones para determinar si el problema se puede 
corregir con los procedimientos sugeridos.

Problemas Causas posibles Soluciones

Los archivos no se pueden guardar 
(transferir) al instrumento aunque la 
aplicación esté conectada a él.

No hay instrumentos configurados para 
ninguno o ambos MIDI Input/Output Device.

Asegúrese de que el instrumento conectado 
está correctamente configurado como MIDI 
Input/Output Device en Ajustes.

No se pueden especificar acordes desde el 
instrumento durante la vista previa de estilo 
aunque la aplicación esté conectada al 
instrumento.

El [ACMP] del lado del instrumento está 
activado. Cuando [ACMP] está activado, la 
información de acordes sólo se envía al 
instrumento y no al ordenador.

Apague el [ACMP] del instrumento.

La pantalla de la aplicación se oscurece. La ventana se maximiza. Si se utiliza la 
aplicación con la ventana maximizada, la 
visualización de otras ventanas puede verse 
distorsionada debido al procesamiento del 
sistema operativo.

• Pulse la tecla [ESC] para cancelar la 
maximización de la ventana.

• Utilice la aplicación sin maximizar la 
ventana.
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